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1. Introduction 
FX Connect (FXC) is a real-time meteorological display system with collaborative capabilities. It is the 
key component of a development project which explores distributing workstation and server functions 
over different remote locations. A unique feature of FXC is that it can accommodate the interaction of 
forecasters at different locations through a graphical user interface. When connected to an AWIPS Server, 
FXC allows the display of selected data and imagery over which graphics may be created, manipulated, 
and viewed by remotely located collaboration participants.  

This Guide provides a brief overview of the system architecture and describes the many functions 
available from the FXC User Interface. The system emulates the AWIPS User Interface design and takes 
advantage of the display generation capabilities of AWIPS. As this system is applied to the needs of 
various users, some customization of the Main Menu and data selectors has occurred. Slight variations 
will exist in Main Menu layout and content. This Guide applies generally to systems known as FX 
Connect, FX Collaborate, and the Briefing Tool.  

FXC features include the conventional capabilities of:  

 Display of diverse data sets (images, observations, and text); 
 Interactive display manipulation (zoom, pan, toggle overlays, overlay color); 
 Interactive display generation (cross sections, time series, time/height, model soundings); 
 Extensive manual graphic and annotation tools; 
 Display procedures. 

 
Advanced capabilities of FXC include:  



 Slide creation and presentation; 
 Chat capability; 
 Internet access to WWW products 
 Display of radar data from any WSR-88D radar; 
 Creation and display of JPEG images; 
 Independent or collaborative mode of operation. 

1.1 Scope 
This document serves as a guide to the use of FXC in data display, interactive graphics creation, 
and forecaster collaboration. Technical details of FXC architecture and server configuration will 
be described in separate documents. 

1.2 Intended Audience and Assumed User Skills 
This guide is intended for use by weather forecasters and other users of hydrometeorological data. 
We assume that users of this Guide have a basic understanding of, and experience with, using a 
mouse to navigate a graphic user interface. This includes such operations as opening, closing, 
resizing, and moving windows, and selecting items from menus. While FXC is designed to have a 
"look and feel" similar to that of AWIPS D2D, knowledge of D2D is not necessary for the 
successful use of FXC. However, familiarity with AWIPS D2D and its associated data and 
displays should be helpful in learning to use FXC. 

 

2. FXC Architectural Overview 
The FXC System consists of two major components: the client that allows the user to display and interact 
with meteorological data and the server(s) that is responsible to provide various types of data to the client. 
For some applications (e.g. Briefing Tool) the client and servers reside on the same machine.  

FXC Clients are usually located remotely. In order for a client to connect to a server, the user selects the 
desired server from the FXC Menu. Once the connection is made to the server, the client has access to a 
large set of data stored on the AWIPS Database. Some menu items and table changes are necessary to add 
additional AWIPS products to the FXC menus. 

The FXC Server comprises a collection of server processes: DepictableServer, ScribbleServer, 
ChatServer, BaselineServer, PointServer, DispatchServer, and FileMonitor. The two processes that are of 
particular interest are the DepictableServer and ScribbleServer. The DepictableServer is responsible for 
interfacing with the AWIPS Software and exporting graphic products. It must therefore be hosted on a 
machine that has direct access to the AWIPS Database and is able to run the AWIPS 5.0 (or later) 
software. The ScribbleServer is responsible for coordinating graphical annotations among multiple users. 
The location of the ScribbleServer and other servers is more flexible and it is anticipated that in the future, 
FXC may actually reassign these server processes automatically if the hosts fail. During a collaborative 



session each server communicates with the clients independently, i.e., it does not broadcast the data to all 
clients. As a result, some degradation in performance may occur when a large number of clients are 
connected for a collaborative session.  

Although the AWIPS Database is the primary and most extensive source of data, FXC can also obtain 
data (in image form) from Web servers and integrate data from other sources. The local data integration 
capability is restricted at this time to display of surface data that has been stored in netCDF format. Figure 
1 illustrates the different data sources available to a user. 

 
Figure 1. FXC Data Sources 

FXC is a multi-threaded Java application. It executes on PCs running Win98, WinNT, Win2000, Windows XP, 
and Linux. Recommended machine attributes include 1 GHz cpu speed, 1 GB RAM, and 20 GB or larger disk. A 
network connection (DSL, ISDN, or Ethernet) is also necessary. 

2.1 FXC Operating Modes 
FXC has three basic operational modes: local, remote, and collaborative.  
   



 Local Mode - In local mode, the client is not connected to any AWIPS Server. However, the user 
does have access to selected data from remote Web servers and possibly some local data. This 
mode is useful for preparing briefing displays that do not require real-time data. 

 

 Remote Mode - In remote mode, the user is connected to an AWIPS Server that the user has 
selected from the FXC Menu. This allows the user to access real-time meteorological data at the 
remote server. The user can display a variety of data and perform such functions as zooming, 
panning, changing colors, overlaying graphics, and animation on the client. The FXC Server can 
accommodate a number of concurrent and independent clients. The maximum number of clients is 
controlled from a menu on the server. 

 

 Collaborative Mode - In collaborative mode, the user can perform all of the same functions as in 
remote mode with the added capability of simultaneously updating or controlling the screen of 
other users. An extensive drawing capability is available that allows the user to annotate the screen 
and share the annotation with the other collaboration session participants. There is also a chat 
capability that allows users to exchange text messages. Only one collaborative session can be held 
at a time. All users connected to a common server are part of the same session. The session can 
remain active although all clients have disconnected from the server. This allows users to rejoin 
the session at a later time. 

2.2 Input Devices 
There are two devices which enable the user to put information into the FXC Graphical Interface to 
invoke a desired action: a mouse and a keyboard.  

2.2.1 Keyboard Functions 

The keyboard is used to enter text in the Discussion Graphic User Interface for "chat" 
functionality with collaboration participants. The keyboard is also used to enter AFOS text 
product identifiers into the text interface. Additionally, the keyboard is used for annotating 
manually-generated graphics. Most FXC display functions may be performed using the keyboard 
by holding the Alt Key and striking the "Hot Key" indicated by an underlined character in every 
menu and submenu. Finally, certain menu commands may be invoked using "Accelerator Key" 
combinations listed to the right of the associated menu items; for example, Ctrl+A will toggle 
looping just as if the user selected the Looping Menu item. 

2.2.2 Mouse Functions 

The mouse is used in a conventional manner for all other FXC actions. The mouse functions are 
designed for a three-button mouse. In the event that FXC is running on a system with a two-button 
mouse, button 2 (middle) functions may be accomplished by pressing and holding the "Alt" Key 



and clicking with button 1 (left). Two examples of button-2 functions are zooming a display or 
toggling the Manual Graphics to editable mode.  

Basic display functions of zoom, pan, and unzoom are performed using the mouse. Clicking 
mouse button 2 will cause the display to incrementally zoom, centered on the position of the 
mouse cursor. One click of mouse button 1 will incrementally unzoom, with the resulting display 
centered on the position of the cursor when clicked. To pan a zoomed display, press and hold 
mouse button 2, then drag the cursor in the desired direction to shift the display. The panned 
display will center on the location of the mouse cursor when button 2 is released.  

Displayed products may be toggled on and off by placing the mouse cursor over the desired 
product legend (in the lower right portion of the display) and click once with mouse button 1. To 
change the color of a graphic overlay or background map, place the mouse cursor on the desired 
product label and click once with mouse button 3 to reveal a pop-up menu with color selections. 
Additionally, any individual displayed product may be unloaded from the display by placing the 
mouse cursor over the selected product label and clicking once with button 3, revealing a pop-up 
menu, and selecting the "Unload" option.  

Other mouse functions are toggling background maps and map legends on and off of the display, 
and unzooming to 1:1. These display controls are available in a pop-up menu which is revealed by 
placing the mouse cursor anywhere in the main display window and clicking once with mouse 
button 3. The resulting pop-up window offers:  

 Show Maps (toggle on or off); 
 Show Map Labels (toggle on or off); 
 Zoom 1:1. 

Summary of mouse button functions:  

 Mouse Button 1 (left) - click to zoom out (unzoom). The resulting display will be 
centered on the pointer. 

 
NOTE: Unzoom is disabled with any editable graphic (Baselines, Points, Drawing Too

Toggle the editable graphic to uneditable to unzoom. 
 

 Mouse Button 1 (left) - click with the pointer over a product legend to toggle that product 
on or off of the display. 

 

 Mouse Button 1 (left) - press the Ctrl and Shift keys while clicking with the pointer 
anywhere in the display to obtain a continuous data read-out. Once the information is 
displayed, Ctrl and Shift no longer need to be pressed. 



 

 Mouse Button 2 (middle) - with the pointer in the display window, click to incrementally zoom. 
Zoomed display will be centered on the cursor position. 

 

 Mouse Button 2 (middle) - with the pointer over an editable product legend (Baselines, Points, 
Drawing Tools), click to toggle between editable and not editable. 

 

 Mouse Button 2 (middle) - press and hold while dragging the pointer to pan a zoomed display. 
The display will center on the cursor when the button is released. 

 

 Mouse Button 3 (right) - click with the pointer over a product legend to open a popup menu from 
which you can change overlay color or unload that product from the display. 

 

 Mouse Button 3 (right) - click with cursor anywhere in the display to open a popup window that 
provides options to zoom out to 1:1, or to toggle map backgrounds and map legends. 

 

3. User Interface Description 
NOTE 

Since the menus vary with location and application, the menus shown in the 
examples may differ somewhat from the ones on your system. 

To start the FXC session, click on the blue background screen and select Start Briefing Tool (see Figure 
2.1.2-2). After a few seconds, the FXC Window will appear. The FXC User Interface, as shown in Figure 
2, includes a Title Bar, Menu Bar, Main Toolbar, Display Pane, and a Status Bar. FXC will initialize with 
several default display settings. All settings and selectors will be described in subsequent sections. 



 
Figure 2. Initial State of the FXC User Interface 

3.1 Menu Bar 
The Menu Bar is located at the top of the FXC Window, just below the FX Connect Title Bar. It is 
a permanent part of the window and cannot be hidden or relocated. All menus are selected with 
one click of mouse button 1. The following sections describe each button on the Menu Bar. All of 
FXC actions may be performed with selectors in the Menu Bar Pull-Down Menus or by selecting 
the corresponding button on the Main Toolbar.  

3.1.1 File Menu 

The File Menu, shown in Figure 3, provides basic file operations and related functions. It 
also includes the Exit Button to close the FXC Window. 



 
Figure 3. File Pull-Down Menu 

 Server  

The user can select the data server from this menu or directly from the main 
toolbar. The data server is the primary source of meteorological data and can be 
located on the same machine or remotely. 

 Collaborate  

The collaborate toggle selector enables or disables collaboration by connecting to 
the appropriate data server. It is more expediant to select collaboration first and 
then select the desired server. 

 Capture D-2D Display  

If FXC is running on the same machine as an AWIPS workstation then it is 
possible to import the main pane of the AWIPS display into FXC. This requires 



that D-2D run a very light-weight application that enables this transfer of occur 
(this is not a remote capability). 

 Load GIF/JPEG/PNG ... 

This selector opens a window for selecting the desired image file. Any GIF, JPEG, 
or PNG image available on the local (or NFS mounted) disk can be loaded into the 
display window. The image will be loaded into the frame currently selected and 
displayed. By advancing the frames, the user can load different images into each 
frame. When in collaborative mode, these images are also shared with the other 
FXC Clients. A File Browser Menu pops up when this selection is made that allows 
the user to choose the desired directory and file to be loaded. 

 Save as JPEG... 

Any product or combination of products (i.e., overlays and manual graphics) 
displayed on the FXC Display Pane may be captured in JPEG format. This allows 
users to create meteorological products that can be placed on a Web server for 
access by the public or a selected set of users, or to create a slide for use in a slide 
show. Upon selecting "Save as JPEG...", a window appears in which to specify 
filename and directory to be used. 

 Set JPEG Resolution... 

This sets the default width for any JPEG that is saved with the "Save as JPEG" or 
"Send to Web Server" selector. The height of the JPEG image is adjusted so as to 
retain the proper aspect ratio. 

 Send to Web 

The user has the ability to create a JPEG image of the display and send it to a Web 
server for access with a Web Browser. The location of the server is defined during 
software installation. 

 Close Web 

Replaces the Web image on the Web server with a default image. 

 Edit Watch/Warning Graphic 

FXC can automatically display a watch/warning box that is generated on AWIPS 
providing the proper Informix triggers are set. The user then has the ability to 
further refine this watch/warning box using the drawing tool. 

 Send to Reverse-911 Database 



This selector initiates transfer of an XML file containing the vertices of the 
watch/warning polygon and sends them to a reverse-911 provider using the https 
protocol. 

 New Procedure... 

(This is a similar to the Procedures feature on D2D, with a few limitations.) The 
user has the ability to create a procedure that consists of a sequence of 
meteorological products that have been loaded to the large display pane from the 
FXC Pull-Down Menus. Data that are overlaid together on the large display pane 
are called Bundles, as shown in Figure 4. 

 
Figure 4. FXC Procedure Dialog Box 



 View Procedure... 

This option opens the Open Procedures Dialog Box, which contains a list of 
existing Procedures. 

 Copy Procedure... 

If you want to generate a copy of an existing Procedure, use this option to open the 
"Procedure to be Copied" Dialog Box. Select the name of the Procedure you wish 
to copy and press the OK Menu Button. Immediately the New Name for Copy 
Dialog Box opens in which you can type in a new name for the copied Procedure. 

 Remove Procedure... 

This option allows you to permanently remove a Procedure through the Remove 
Procedure Dialog Box which lists all existing Procedures. To remove a procedure, 
select the procedure to be removed (one click with mouse button 1 to highlight the 
procedure to be deleted), then select "OK." 

 New Slide Show... 

The FXC Briefing Tool allows you to create a list of image, text, or combined 
image-text "slides" to be used for presentations and weather briefings. You can 
build each slide using D2D weather products, weather briefing text templates that 
can be edited to include up-to-date launch weather information, or you can import 
any image files (in JPEG, PNG, or GIF format). Refer to Figure 5. 



 
Figure 5. FXC Slide Show Dialog Box 

 View Slide Show... 

This option opens the Open Slide Show Dialog Box which contains a list of 
existing slide shows. (Note: some menus also allow the user to view a slide show 
by clicking the shuttle icon on the tool bar.) 

 Copy Slide Show... 



If you want to generate a copy of an existing slide show, use this option to open the 
"Slide Show to be Copied" Dialog Box. Select the name of the slide show you wish 
to copy and press the OK Menu Button. Immediately the New Name for Copy 
Dialog Box opens in which you can type in a new name for the copied slide show. 

 Remove Slide Show... 

This option allows you to permanently remove a slide show through the Remove 
Slide Show Dialog Box which lists all existing slide shows. To remove a slide 
show, select the name to be removed (one click with mouse button 1 to highlight 
the procedure to be deleted), then select "OK." 

 Set Working Folder... 

The user can define the default folder that will be used to access existing or store 
newly created slide shows. 

 Set User Information... 

(Not activated for all users) Allows users to specify the name to be used for chat 
sessions. This name is also used by the server to allow or disallow a user to connect 
to the server. The User Information Menu also lets the user select the color to be 
used for all text generated by the user during a chat session. 

 Restart Server... (Reset window) 

This selector allows the user to restart the background (or remote) process that 
accesses the AWIPS database. The user will be prompted to confirm the reset. The 
reset takes two to three seconds and clears all information on the screen. 

 Log Messages 

Diagnostic messages are being generated and recorded for most actions performed 
by the user. The messages are stored in the /awips/fxa/FXC/fsl/data/logs directory. 
These messages make it possible to troubleshoot the system should an error occur. 
The logs should be purged regularly to prevent the disk from eventually filling up. 
The user can disable the logging function each time the system is started by 
toggling this switch off. 

 Exit 

This causes the FXC Client to terminate and close all FXC Windows displayed on 
the screen. 

3.1.2 View Menu 



The View Pull-Down Menu, shown in Figure 6, contains options for manipulating the 
display. Most of these options are available in the more accessible toolbars, but are 
intentionally included in the View Menu for design redundancy. 

 
Figure 6. View Pull-Down Menu 

 Clear 

This menu option removes all data products from the display pane, leaving only the 
original map background. This same action is more commonly performed from the 
Clear Button on the toolbar. 

 Update 

Use this menu option, or the Update Icon in the Toolbar, to refresh the display with 
the most current data. 

 Step Back/Step Forward 

These two menu options advance the data frames that are displayed forward or 
backward through time. The more typical way to perform these same actions are 
with the Arrow (< >) Buttons on the toolbar, or the left and right arrow keys on the 
keyboard. 

 First Frame/Last Frame 

Use these two menu options to jump to the first or last data frames. It is easier to 
perform these same actions by using the First Frame (|<) and Last Frame (>|) 
Buttons on the toolbar, or by pressing the control key in conjunction with the left or 
right arrow keys. 

 Looping 



This radio button toggles on/off the animation capability, which can also be 
performed from the toolbar using the Loop Icon, or by pressing the control and "A" 
keys. 

 Previous Bundle/Next Bundle 

These options can be used when displaying data products through the Procedures 
feature. Refer to Subsection 4.2 for more information about Procedures. 

 Show Line Cursor 

It may be useful to display a movable horizontal line to underscore an item on a 
slide during a slide presentation.  

3.1.3 Options Menu 

The Options Pull-Down Menu, illustrated in Figure 7, contains selectors for controlling 
data display characteristics. 

 
Figure 7. Options Pull-Down Menu 

 Data Scale 

This feature, when toggled on (check-marked), causes the next product selected 
from the data menus to be loaded on the scale appropriate for the data, not 
necessarily the scale selected on the menu. For example, when a single site radar 
product is selected from the menu, with "Data Scale" toggled on, the radar image 
will be displayed with the radar centered in an area covered by the radar. 

 Display Properties... 



This submenu, shown in Figure 8, includes additional submenus that allow you to 
manipulate the display properties of the FXC Display Panel. 

 
Figure 8. Display Properties Submenu 

 Area 

AWIPS data is stratified into geographic scales, as shown in Figure 9. The 
geographic scales are organized to "funnel" in on a specific local area. Each 
geographic scale may have data sets unique to that scale. For example, mesonet 
data would not be available on North American scale. Data displayed at higher 
scales typically contain coarser resolution. 

 
Figure 9. Area Submenu 

 Load Mode 

The Load Mode Submenu is shown in Figure 10. 



 
Figure 10. Load Mode Submenu 

Each time you select a product from the menu, a number of frames (equal to the 
frame count) are loaded into memory. Normally, each frame is loaded with a 
sequentially older product. However, sometimes you may want to view products in 
a different manner. This menu allows you to select from a number of different Load 
Modes. A brief description of each Load Mode follows.  

 Latest Run - Displays forecast data only from the latest model run, but also 
backfills with frames from previous runs at the beginning of the loop to 
satisfy the requested number of frames. 

 Valid Time Sequence - This Load Mode displays the most recent data and 
fills empty frames with previous data. For models, it provides the product 
from the latest possible run for every available valid time. 

 No backfill - Displays model data only from the most recent model run 
time with no backfilling to fill out a loop. Using this Load Mode prevents 
the mixing of old and new data. 

 Previous Run - Displays the previous model run, backfilling with frames 
from previous runs at the beginning of the loop to satisfy the requested 
number of frames. 

 Previous Valid Time Sequence - This Load Mode displays the previous 
model run and fills empty frames with previous model data or analyses. 

 Analysis Loop - This Load Mode loads a sequence of model analyses, but 
no forecasts. 

 Forecast Match - Overlays a model product only when its forecast times 
match those of an initially loaded product. This Load Mode is available 
only when another product is already loaded in the large display pane. 

 Frames 

Use this menu, which is depicted in Figure 11, to select the number of frames to 
load to a display animation. Keep in mind that longer animation loops take more 
time to load, so adjusting the frame count to a low value will facilitate faster 
loading, especially through a modem connection. 



 
Figure 11. Frames Submenu 

 Character Size 

It is possible to modify the size of graphical characters with the Character Size 
Submenu, shown in Figure12. 



 
Figure 12. Character Size Submenu 

 Display Density... 

The user can specify the amount of data to be shown on the screen by specifying 
the appropriate density value. The display density is a relative number and the 
amount of data displayed is also determined by the window size.  

 
Figure 13. Display Density 

 Loop Properties... 

This menu option opens the Loop Properties Dialog Box, shown in Figure14. 
Within this dialog box are controls for the various features of an animation. You 
may alter the dwell at the end of a loop, the speed of animation, and the direction 
(forward or backward) of the animation. 



 
Figure 14. Loop Properties Dialog Box 

 Image Properties... 

This menu option opens the Image Properties Dialog Box, depicted in Figure 15. It 
contains slider bars allowing you to control the opacity of an image. This feature is 
particularly useful when several overlays are placed on top of an image. By 
reducing the opacity of the image, the graphic overlays become more discernable. It 
is also possible to combine two images by enabling the "Combine Images" selector. 
When enabled, the next image to be loaded will be combined with the current 
image. Toggling the selector off will resume normal load operation. The "Lock 
Image Opacity" selector will cause the opacity of the two images to always add to 
100%. Thus, if the opacity of one image is reduced, the opacity of the other image 
will be increased. 



 
Figure 15. Image Properties Dialog Box 

 Image Color 

This submenu, shown in Figure 16, contains a number of pre-defined color tables 
available for image enhancement. The color table will be applied to the currently 
displayed image. The user can easily revert to the default image enhancement by 
selecting the item "Default" from the Color Table Menu. 

 Second Image Color 

This menu is only active for image combinations. When combining two images, 
this menu provides the color table choices for the second image. 



 
Figure 16. Image Color Submenu 

 Color Table Editing 

The Color Table Editing menu is used to create a new or modify an existing color 
table. When selected, a submenu appears that prompts the user for the name of the 
new color table or the one to be edited (Figure 16a).  



 
Figure 16a. Color Table Editing Submenu 

When creating a new color table the user is prompted for the name of an exisiting 
color table that is to be the starting point for the new table. The menu shown in 
Figure 17 provides a list of the existing color tables in the system. When done, the 
custom color table will be saved and the Image Color Submenu will be updated 
with the name of the new color table. The color tables can be applied to all images 
(except TIFF, GIF, JPEG, and PNG).  

 
Figure 17. Table Selector Menu 

Figure 18 illustrates what a typical Color Table editing window looks like. The user 
can select a single color index by either clicking on the color bar or selecting the 
desired index with the thumbwheel selector. If the user wants to select a range of 
values then the second index can be selected by pressing the shift button on the 
keyboard while also pressing mouse button 1 over the deired location on the color 
bar. Alternatively, the user can enter the desired index into the second thumbwheel 
seletor. The user can select a solid fill or linear interpolation between the two 
indices by clicking Single... or Linear..., respectively. The standard color palette 
(see Figure 19) will appear and the user can select the desired colors. 



 
Figure 18. Color Table 

Figure 19 shows the standard color menu for selecting background, overlay, and 
image colors. The user can either select a color from one of the swatches, set the 
HSB values, or define the color by specifying the RGB components. A color 
swatch on the menu changes color as you adust the various color components. 
Once, satisfied with the color the user needs to click on "ok" to save the color 
setting. 

 
Figure 19. Display Colors 

 Display Size 



You can resize a window by either selecting one of the predefined sizes from the 
Display Size Submenu, shown in Figure 20, or by grabbing the edge of the display 
and reshaping the window to the desired size. The attributes of a window are saved 
in a state file to allow the window to reappear in the same location and of the same 
size the next time the window is opened. 

 
Figure 20. Display Size Submenu 

 Toolbars 

FXC has two toolbars; The Main Toolbar contains the basic controls of the display 
and a second, the Drawing Toolbar, is used in conjunction with the drawing tool. 
All of the functions in the toolbar are also available from the Main Menu Bar. It is 
therefore possible to hide the toolbar and still have access to all of the toolbar 
functions. The Drawing Toolbar is visible when the Drawing Tool is loaded from 
the Tools Pull-Down Menu, shown in Figure 21, and is made "editable" (by 
clicking on the "Manual Product" legend once with mouse button 2). This is 
discussed further in the Section 3.1.4, "Tools Menu." 



 
Figure 21. Toolbars Submenu 

 Change Display Colors 

This submenu, shown in Figure 22, allows the user to change the default colors for 
the display window background (typically black) and the graphic overlays. By 
selecting the desired item and clicking on "change" the standard color palette (see 
Figure 19) will appear and the user can select the desired color. The default 
information will be saved in a state file and will be recalled the next time FXC is 
started. If the user wants to change the color only for a particular graphic on the 
current display, then the user can button-3 click on the product label and change the 
color of the graphic. Clearing the screen will then set the color back to the default. 



 
Figure 22. Display Palette 

 Set Clock Time 

The "Set Clock Time" menu, shown in Figure 23, allows the user to either select 
real-time mode or define the desired date and time desired by the user. The date and 
time specified in the menu will be used to access the meteorological data saved on 
a disk. The date and time in the menu will be recalled the next time the "Set Clock 
Time" menu is opened. The date and time in the lower right hand corner of the 
display will have a yellow background when the date and time are not set to the 
current time. 

 
Figure 23. Set Clock Time Menu 



3.1.4 Tools Menu 

The Tools Pull-Down Menu, shown in Figure 24, provides selectors for interactive FXC 
capabilities. Each tool is described as follows. 

 
Figure 24. Tools Pull-Down Menu 

 Baselines 

When selected, a number of interactive baselines appear on the display. If the 
display is zoomed to a small geographic area, the baselines may not be visible. 
Unzooming may be necessary to view and move the baselines. Baselines may be 
arbitrarily placed for the purpose of creating a vertical cross section from model 
data through the use of the Volume Browser. Note that one end of the baseline line 
segment is labeled A through J. The resultant vertical cross section will be 
displayed with the label end of the baseline plotted on the right side of the cross 
section. In other words, if a west to east cross section is to be created, and the user 
wishes the cross section to be displayed with west on the left, position the baseline 
with the letter label on the right side.  

To move a baseline, first note if the product label indicates "editable" mode, i.e., 
"Interactive Baselines (editable)." If the word "editable" is not visible, click once 
with mouse button 2 with the cursor on the product label to toggle the baselines to 
"editable". Now to move a baseline, place the tip of the mouse cursor on the 
baseline and click once with mouse button 1. The shape of the cursor will change 
from an arrow to a hand when the baseline is successfully grabbed. Then relocate 
the cursor to the desired location of the baseline and click once again with button 1.  

To move a vertex of the baseline, click once with mouse button 1 with the tip of the 
arrow cursor on the end of the baseline to be moved. The cursor shape will change 
to a cross-hair when successfully grabbed. Then click once more in the desired new 
location for the baseline end point.  

Note: To move an editable object (baseline, point, manual graphics glyph/symb
the object; then move the mouse to the desired location for the object, an
there. 

 Points 



Similar to the editable baseline, editable points are used to locate model-derived 
soundings, time series, or time height model plots. Point A is also used in the Data 
Scale Load Mode for radar images and for displaying model soundings from the 
volume browser.  

Manipulation of editable points is the same as that for baselines. Make sure the 
product label indicates "editable", place the tip of the mouse cursor over the point 
to be moved, and click once with mouse button 1. The shape of the cursor will 
change from a left-slant arrow to a hand. Move the cursor to the desired location 
and click once again with mouse button 1. 

 Drawing 

This selector invokes a manual graphics capability. A Drawing Toolbar will appear 
along the top of the FXC Display, below the Menu Bar, and the product label 
"Manual Graphics (editable)" appears in the lower right corner of the display. More 
information on the drawing features is presented in Subsection 3.3. 

 Tool-Specific Commands 

This selector becomes active when the drawing tool has been selected. The 
submenu for this selector replicates the drawing tool functions that are also 
accessible using the icons in the toolbar. 

 Text Window 

This selector invokes an AWIPS Text Window, as illustratrated in Figure 25, in 
which any NWS text product carried on the Satellite Broadcast Network may be 
displayed. This window may also be used as a "notepad" for creating text. Selectors 
for easy access to AWIPS Text Products are available under the "Products" Menu. 
This list may be modified to suit the needs of the local office. 



 
Figure 25. FXC Text Window 

 Text Chat 

Select this button to open a "chat room" window. The FXC must be connected to a 
server and be set to collaborative mode to use this feature. Each collaboration 
participant will be listed in the Discussion Window, shown in Figure 26. 



 
Figure 26. FXC Discussion Window 

To the left of the collaborator's name is a small check box that enables an audible 
alarm whenever a mesage is received from that user (even if the window is hidden 
from view). The "Options" selector in the Discussion Window Menu Bar opens a 
menu that allows users to select a word or combination of words that will alert the 
user whenever that text string occurs in any of the discussion. 

3.1.5 Volume Menu 

The Volume Pull-Down Menu, shown in Figure 27, provides access to displays of graphics 
created from model grids. 



 
Figure 27. Volume Pull-Down Menu 

 Browser 

This selection opens a window called the Volume Browser (Figure 28) that 
provides menus from which a vast number of model analysis and forecast fields 
may be produced. The overall design and functionality is similar to the Volume 
Browser in AWIPS D2D, with a few exceptions. Selections must be made in order 
from left to right, first selecting a model or models, then fields, then planes. 
Displays may be created as graphics or images. Conventional plan view displays, 
cross sections, time series, time/height sections, and model soundings can be 
created using selections in the Presentation Pull-Down Menu (Figure 29). 

 
Figure 28. Volume Browser  



 
Figure 29. Volume Browser with Presentation Options Menu 

 Families 

Choosing either the RUC, ETA, or gfs family of graphics results in a display of a 
selection of eight conventional graphics of upper air and surface parameters from 
the chosen model. The first two graphic overlays are displayed, while the following 
six are suppressed. To toggle a graphic on or off, simply click once with mouse 
button 1 with the tip of the cursor on the product legend. 

 Comparison Families 

Selecting either 500 Height or MSL Press will display a selection of nine graphic 
overlays from several NWS models. In the case of "500 Height", the display is of 
the 500 MB height from the MRF AVN, MesoEta, Eta, NGM, and RUC. "MSL 
Press" will load the MSL pressure from the same models. 

 Surface Families 

This selector will display the surface forecast products for the ETA12 forecast 
model. The precip image is loaded first, but not displayed, and must be toggled on 
in order for it to be visible. 

3.1.6 Obs Menu 

This pull-down menu and associated submenus provide access to a variety of observational 
products, including METAR and buoy plot displays, tower plots, and lightning. Depending 
on the application, this menu may also provide access to certain Web products 
(GIF,JPEG). Furthermore, it allows users to overlay (single color) a hand drawn local 



graphic product into one or all frames using the "Local Graphic" selector. Refer to Figure 
30. 

 
Figure 30. Obs Pull-Down Menu 

3.1.7 NCEP/Hydro Menu 

The NCEP/Hydro Pull-Down Menu, shown in Figure 31, contains National Center 
graphics and analyses. 

 
Figure 31. NCEP/Hydro Pull-Down Menu 

3.1.8 Upper Air Menu 

Mandatory level upper air plots, raobs plotted on a Skew-T diagram, Profiler time/height 
and plan view plots, and selected AWC products are available under this menu, as depicted 
in Figure 32. 



 
Figure 32. Upper Air Menu Pull-Down Menu 

3.1.9 Satellite Menu 

A selection of GOES images is available under the Satellite Menu, as illustrated in Figure 
33. Temporal and spatial resolution of the images is dependent upon the scale at which 
they are loaded. 

 
Figure 33. Satellite Pull-Down Menu 

3.1.10 Radar Menus 

The kxxx and Radar Menus, in Figures 34 and 35, contain selectors for various radar 
images and products. A national reflectivity mosaic is available, as well as selected base 
reflectivity and velocity images. 



 
Figure 34. kxxx - Local Doppler Radar Pull-Down Menu

 
Figure 35. Radar Pull-Down Menu 

3.1.11 Maps Menu 

This menu, shown in Figure 36, allows the user to access a variety of background maps for 
FXC Displays. 



 
Figure 36. Maps Pull-Down Menu 

 

A background may be toggled on or off in two ways. Click once with mouse button 1 on a 
map name on the Maps Menu to toggle on or off the selected map display. Map labels may 
be toggled to display in a like manner. With the map labels visible in the lower right corner 
of the display ("Show Map Labels" toggled on in the Maps Menu) maps may also be 
toggled on or off by clicking once with button 1 on the map label. The user may also select 
a color for a map. 

3.1.12 Help Menu 

The Help Menu contains the About... option which opens the About FXC Window that 
contains software version and date information. Refer to Figure 37. 



 
Figure 37. Help Menu and About FXC Window 

 

 
Figure 37a. Help Topics Menu 



3.2 Main Toolbar 
The Main Toolbar, shown in Figure 38, is found just below the Menu Bar and provides shortcuts 
for many of the Display controls found in the Menu Bar. This toolbar can be hidden from view 
using the toggle switch just under the File Menu. The function of each selector on the Main Menu 
Bar is identified with "tool tips". Simply move and dwell the mouse cursor over the desired 
selector and a "tool tip" will appear identifying the selector. 

 
Figure 38. Main Toolbar 

3.2.1 Server 

This allows the user to connect to the desired AWIPS Database. The selector identifies the 
AWIPS "localization" and geographic location of the FXC Server. The user can connect to 
a server that resides on a remote machine or on the same machine as the client. 

3.2.2 Collaborate 

(This feature not enabled for all releases.)  

This sets the collaborative mode. All collaboration participants (FXC Clients) must be 
connected to the same FXC Server to utilize Collaborative Mode. Most of the actions by 
the user are shared with the remote collaborators. For example, a user can load an image, 
overlay model data, zoom in on a specific area, and then start an animation and have all of 
these actions performed on the other FXC Clients who have also enabled collaboration 
while connected to the same server. A key collaborative feature is the ability to annotate 
and draw onto any product displayed on the screen. Actions that are not currently shared 
include changing color enhancements, adjusting image intensity, and overlaying additional 
map backgrounds. Some of these may be added in the future. Also, with FXC set to 
Collaborate mode, a "chat room" capability (labeled "Discussion"on the Tools Menu) is 
available that allows users to exchange textual messages and determine who is 
participating in the collaboration session. 

3.3 Drawing Toolbar 
A variety of drawing and annotation capabilities are available on FXC through the Drawing 
Toolbar. When "Drawing" is selected from the Tools Menu, the Drawing Toolbar initially appears 
at the top of the FXC Display, just below the Main Toolbar, as shown in Figure 39. 

 



 
Figure 39. Drawing Toolbar (Shown in the Default Horizontal Layout) 

 

This toolbar may be "torn away" from the Main Toolbar by grabbing the Drawing Toolbar with 
the cursor at the left edge by pressing and holding mouse button 1. A vertical or horizontal layout 
is possible by clicking once with mouse button 3 with the cursor in a blank gray area between 
buttons on the toolbar. The choices "Horizontal", "Vertical", and "Rejoin Main Window" will 
appear for user selection, as shown in Figure 40. 



 
Figure 40. "Vertical" Drawing Toolbar 

The selectors on the Drawing Toolbar allow the creation, selection, or saving of files and selectors 
to create, manipulate, and annotate manual graphics. Pausing the mouse cursor over the buttons on 
the toolbar will reveal tool tips describing the function of each button.  

3.3.1 New Drawing  



This selection erases the drawn objects and leaves all of the graphic overlays and underlay 
in tact. This is unlike a Clear that erases the overlays, underlay, and removes the drawing 
tool. 

3.3.2 Open Drawing  

This selection retrieves the object file containing the drawing and displays it on the screen. 
The drawing is retrieved with all of its original attributes and can be modified totally. 

3.3.3 Save Drawing  

A drawing is always saved in two different formats: a graphic metafile and an object file. 
There are twelve predifined files that can be used. The first eight can be used for storing 
sequential drawings (frame-to-frame) and the last four are independent drawings. The 
object file is retrieved by selecting Open Drawing for additional editing, and the metafile is 
retrieved as a single color graphic by selecting Local Graphic from the Obs Menu. 
(Selecting "Graphic Sequence" will load the first eight drawings into sequential frames.) 

3.3.4 Undo  

Each time this button is selected, the last action is undone up to 32 steps. 

3.3.5 Redo  

Each time this button is selected, the last action is restored up to 32 steps. 
 
With the following manipulations, first select the function with a click of mouse button 1; then 
click on the object that is to be manipulated and click again on the final desired location (if 
appropriate) for the object.  

3.3.6 Move Glyph  

To move a symbol click-and-release mouse button 1 on the item. This will attach the 
symbol to the mouse cursor. Move the symbol to the desired location and click button 1. 
This will place the object at the specified location. 

3.3.7 Copy Glyph  

To copy a symbol click mouse button 1 on the item. This will attach a copy of the symbol 
to the mouse cursor. Move the symbol to the desired location and click mouse button 1. 
This will place the the copied object at the desired location. 

3.3.8 Erase Glyph  



To erase a symbol or line click mouse button 1 on the item to be erased. 

3.3.9 Edit Freehand Path  

To change the end piece of a line, click-and-release on the line at the desired location, 
draw the new line from that location and click-and-release again to terminate the line. To 
modify a piece of a line, click-and-release on the line at the desired location, draw the new 
line and click-and-release when the new line touches the old line. 

 
The remaining selectors reveal pull-down menus for additional controls for manual graphics.  

3.3.10 Glyph Size  

Specifies the default size of the glyph (symbol or icon) Small, Medium, or Large 

3.3.11 Line Thickness  

Specifies the default thickness of lines; four thickness options are available. 

3.3.12 Line or Glyph Color  

Specifies the default color of glyphs; a pallet of eight colors is available. 

3.3.13 Line Types 

The user has a choice of several different line types to annotate the displays.  

 Solid Straight Line  

 Dashed Straight Line  

 Straight Arrow  

 Freehand  

 Dashed Freehand  

 Arrow Freehand  

 Scalloped  

This line type is frequently used to depict clouds. The "cloud" line type may be drawn as 
Right or Left orientation.  

3.3.14 Front Types 



Front types may be drawn as Right or Left orientation. The default is specified by the pull-
down menu to the right of the symbols. "Right" means that the annotations will be to the 
right of the line as you are drawing it. The orientation can be changed after the line is 
drawn by clicking on the line with mouse button 3 and selecting the desired "Decoration 
Side.." from the pop-up menu.  

 Surface Cold Front  

 Aloft Cold Front  

 Surface Warm Front  

 Aloft Warm Front  

 Surface Stationary Front  

 Aloft Stationary Front  

 Surface Occluded Front  

 Dry Line  

3.3.15 Shape Types 

Select this option to draw shapes. When drawing shapes, an additional pull-down menu 
appears on the toolbar to define the default characteristics of the shape, create shapes with 
or without borders, and drawn as Hollow, Transparent, Translucent, Semi-opaque, and 
Opaque.  

 Polygon  

Use mouse button 1 to select vertices of the polygon, then use button 3 to close the shape.  

 Freehand Polygon  

Click once with mouse button 1 to begin drawing the freehand shape. Then click a second 
time with button 3 to close the shape.  

 Cloud  

This button allows the user to create an arbitrarily shaped cloud by drawing a freehand 
polygon as (described above).  

3.3.16 Precip Symbols 

 Light Intermittent Snow  

 Light Continuous Snow  



 Ice Pellets  

 Freezing Drizzle  

 Rain  

 Thunderstorm  

 Severe Thunderstorm  

 Rain Shower  

 Blowing Snow  

 Blizzard  

3.3.17 Aviation Symbols 

 Turbulence  

 Severe Turbulence  

 Icing  

 Severe Icing  

 Light Fog  

 Fog  

 Haze  

 Smoke  

 Blowing Sand  

 Blowing Dust  

3.3.18 Cloud Cover 

 Clear Sky  

 Scattered Clouds  

 Broken Overcast  

 Overcast  

3.3.19 Combo Symbols 

 Rain/Drizzle  

 Moderate/Heavy Rain  



3.3.20 Other Symbols 

 Low Pressure  

 High Pressure  

 Generic Marker  

 Dust  

 Tropical Storm  

 Wind Barb  

Click once with mouse button 1 at the desired location of the wind barb. A Wind Speed 
selector appears to set the desired speed. Select speed, then select "OK". The wind barb of 
selected speed appears adjustable to direction. Place the cursor to indicate the desired wind 
direction then click once again with mouse button 1.  

The speed and direction of the wind barb can be changed after it has been drawn. To 
change the speed click on the wind barb with mouse button 3 and select "speed" from the 
pop-up menu. To change the orientation of the wind barb select the "Move Glyph" from 
the drawing tool bar and click on the end of the wind barb with button 1. Rotate the wind 
barb to the desired direction and click button 1 a second time. To change the location of the 
wind barb follow the same basic procedure except click on the shaft of the wind barb.  

3.3.21 Text 

 Annotate  

Click once with mouse button 1 at the desired location of the annotation, then a dialog box 
appears for entering the annotation text. Enter desired text, then click "OK".  

 Point Size  

 Bold Face  

 Italic  

3.4 Drawing Tool Practice Module 
One of the powerful features of the system is its ability to annotate a display with graphics or text 
using the Drawing Tool. The objective of this module is to introduce you to some of the basic 
drawing capabilities.  



 

Figure 41. Sample Drawing 

Step-by-step instructions for sample drawing: 

1. From the Main FXC Toolbar, clear the FXC Display Window. 
2. From the Area Options Menu, select CONUS. 



3. From the Surface Pull-Down Menu, select Station Plot. 
4. From the Tools Pull-Down Menu, select the Drawing option (or press CTL-D). The 

Drawing Toolbar automatically appears, and contains many useful features for drawing 
lines, fronts, symbols, etc. Once this toolbar is active, the functionality of Mouse Button 1 
changes to accomodate the drawing and editing of the drawing features. 

5. From the Drawing Toolbar, open the Glyph Choices Options Menu (label changes to 
reflect type of glyphs) and select Front Types. Notice the icons to the right change to 
reflect several line types. Click on the Cold Front Icon. 

6. In the FXC Display Window, click-and-release Mouse Button 1 somewhere on the 
display and notice the cursor becomes a pencil. One end of your line is now anchored at 
the location where you clicked. Move the mouse to another place and click-and-release 
again to define the end point of your line. 

7. Now click on a different Line Type, like the Dotted Freehand Icon. Repeat Step 6. 
8. Under the Glyph Choices Options Menu, choose Precipitation Symbols. Notice how the 

icons change in the Drawing Toolbar. Click on the Light Intermittent Snow Icon. 
9. In the Glyph Size Options Menu (single letter button), select L (large). 
10. In the Display Window, click at the desired locations to place the Light Intermittent 

Snow symbols. 
11. Try using the Undo, Redo, Move Glyph, and Copy Glyph Icons. 
12. Experiment with other Glyph Choices to familiarize yourself with the various features and 

options. 
13. Once you have annotated an image, you can save it for later display/modification by 

selcting the Save Drawing or add it as a slide in a Slide Show. 

3.5 Using the Manual Graphics 
Some adjustments may be made to elements of a manual graphic after they have been drawn by selecting 
the desired element, placing the tip of the mouse cursor on the element (glyph, annotation, line, etc.), and 
clicking once with mouse button 3. A pop-up menu will present options for changing the element, as 
shown in Figure 42. 



 
Figure 42. Pop-Up Options Menu for Manual Graphics 

Alternatively, the elements can also be moved, duplicated, or edited (i.e., line and shape modification) 
using the buttons on the drawing tool bar.  

The manual graphic can be saved as a JPEG for incorporation into a document or sent directly to a Web 
server for display in a Web page (firewall permitting). If sent to a Web server it can be used for real-time 
coordination of weather events between the user and any external consumer that has access to a Web 
browser.  

 

4. Weather Briefings 
There are several tools available to help forecasters prepare and present weather briefings. The most 
commonly used tools are procedures and slide shows. Procedures allow forecasters to set up a sequence of 
forecast products that can be displayed in sequential or random order during a weather briefing. Once a 
procedure is set up, it can be used over and over again on different days to display the current data for that 



day. Forecasters can also display additional data (including graphical annotation) that is not part of the 
procedure without exiting the procedure.  

 

Figure 43. Briefing Slide Components 

Another commonly used tools is a slide show that allows the forecaster to create a series of slides that can 
include AWIPS Displays, special purpose text slides and weather products downloaded from an internet 
server. Figure 43 illustrates the components of a briefing slide. The background image can be any JPEG, 
GIF, PNG, or even the current FXC display. The text component is an html overlay. Slide shows are 
created on FXC and are custom made for each weather briefing. They are played back using the FXC 
slide show capability.  

4.1 Using the Slide Show Functions 
The slide show user interface is designed to allow users to create individual slides and assemble 
them into a slide show. It is envisioned that the user would create these slide shows prior to a 
presentation and then play them back for the actual presentation. Individual slides can be created 
from data displayed on the screen (e.g. a radar loop with lightning data), images loaded from local 
disk or Web, or html text template files. The slide shows can be easily modified to change the 
contents of a slide or to add or delete slides. A special Dialog Menu is provided to create, modify, 
and display slides in a slide show.   

4.1.1 The Slide Show Dialog Box 

To create or modify a slide show the user must first select New Slide Show or View Slide 
Show from the File Pull-down Menu and either give the slide show a name or select an 
existing one. This brings up the Slide Show Dialog Box (Figure 44) that enables the 
creation and modification of a slide. The Slide Show Dialog Box is arranged so that you 
move from top to bottom to specify and create each slide in your slide show. The white 
area at the the top of the dialog box contains a list of all of the existing slides (i.e Bundles). 
This area will be blank if a new slide show is being created.  



 
Figure 44. Slide Show Dialog Box 

The three sections of the Slide Show Dialog Box are:  

 Slides 

This portion of the Slide Show Dialog Box lists the existing slides. When you initially 
open a new slide show, this portion is empty. 
 

 Edit Slide 

In this portion of the dialog box, you can define the component(s) of the slide you want to 
create, and modify existing slides 
 



Slide Composition - As shown in Figure 45, you can choose the components of the 
slide you want to create by selecting the appropriate box(es). Checking Backgound 
Image and disabling Single Slide will create a set of images that can be animated 
(i.e. a multi-frame slide). The components of a slide are:  

 
Figure 45. Select Slide Type Dialog Box 

1. Text Overlay - The basic text and layout is obtained from existing html 
template files. After selecting this option, click on the Create Slide Menu 
Button. The Template Dialog Box will appear and guide you through 
directories and files of pre-made text templates. Once you have choosen a 
template, click on the Open selector to display the text slide. The slide can 
be alterted by selecting Edit Text... (or pressing CTL-E with keyboard focus 
on the slide) which will display a popup menu with the editable fields. 



Refer to Subsection 5.8 for more information on how to create custom 
template files. 

2. Image Background - This will create an image background of whatever is 
displayed on the FXC Screen. This could be anything "captured" from D2D, 
generated on the FXC Display, or an image or background file that you 
obtain via the Load GIF/JPEG/PNG... option from the File Pull-Down 
Menu. Click on the Create Slide Menu Button to create a new background 
slide. Note, background slides can be used to display meteorological data, 
such as radar or satellite images. These slides contain an empty text overlay.  

3. Single-Frame Slide - This check box allows you to capture all or only one 
frame of a multi-frame loop of data. For example, if you load 12 frames of 
the ETA model family, but you only want to capture the 36-hour forecast, 
just step to that frame and then click on the Create Slide Menu Button. Vice 
versa, if you want to capture all of the forecasts disable the Single Frame 
Slide and click on the Create Slide Menu Button. Note: In order to view the 
frame animation the "Animate" button must be enabled. 

Select Operations - Within this portion of the Slide Show Dialog Box are the 
control operations for manipulating the slides and the slide order.  

4. Create Slide - When you choose this option, the contents of the screen will 
be converted to a JPEG image and stored. If you are creating a text slide, a 
listing of html templates will appear. Once you choose an html template 
file, the template will automatically be added to the slide show. To create a 
slide that contains an image background and text, first load the image 
background and then select Create Slide. This causes the Template Dialog 
Box to be displayed. After selecting a template, the background and text 
template will automatically be saved as a slide. 

Slide Modification - Each slide can consist of two components, a background 
image and a text overlay. To edit either one, first select the little lever symbol, as 
shown in Figure 46, to the left of the slide to be modified and then click on the 
component of the slide that is to be changed.  
  



 
Figure 46. Editing a Slide 

1. Rename - A slide can be renamed to give it a more descriptive name by 
selecting this menu button and entering the desired name. 

2. Replace - This button is very powerful since it allows a user to replace any 
component of an existing slide, even if the component is empty. To replace 
the background image, first highlight the background image component for 
the desired slide, load the new background, and then select the Replace 
menu button. This will replace the background (only) for that slide. To 



replace the text overlay, first highlight the text component and then click on 
Replace. This will pop up a menu with the available text templates that can 
be used 

3. Remove - To delete a slide, select the desired slide and click on the Remove 
Menu Button. This function can also be used to delete a slide component, 
i.e. text overlay or background image, by highlighting that component of 
the slide. 

4. Edit Text... - This button will be enabled for any slide that contains editable 
text. To edit a slide select this button and modify the appropriate editable 
fields in the template. Note, the user may also use the shortcut CTL-E (with 
the keyboard focus on the display) to pop up the corresponding text 
template. 

5. Move Up/Move Down - To rearrange the order of the slides in your slide 
show, use the Move Up/Move Down Menu Buttons. 

 Show Slide - To view slides in a slide show during a weather briefing or presentation, 
double-click on the the starting bundle of the desired slide show, and then bring the main 
window to the foreground by clicking on the window frame. Press on the Load Menu 
Button to display the highlight slide, and use the Previous and Next Menu Buttons to 
manually go backward and forward through the slide show. If you want to advance through 
the slides automatically, the user can specify the time delay between slides and enable the 
Auto-Load feature. 

1. Auto-load - Allows the user to automatically step to the next slide after a predefined 
delay. The Auto-load function will repeat the slide show, starting with the first slide 
after the last slide has been displayed. 

2. Set Dwell Time - The time shown in the small window is the delay for the particular 
slide selected in the slide show dialog window. The delay for that slide can be 
modified by changing the value in the window. 

3. Show Line Cursor - For some applications it is desirable to be able to show a 
horizontal line below a line of text that is being discussed. The horizontal line can 
be moved with the mouse by selecting the Move Glyph in the drawing toolbar. 

Note  
When transitioning from one slide to the next, the default background (black) is 

momentarily seen. If this is undesirable, change the background to white by 
selecting Options>Change Display Colors and restarting the application. 

4.2 Using the Procedure Functions 
Procedures are created and modified in a very similar manner to slide shows. A major difference is 
that procedure bundles consist of only one component (graphic product) and therefore are simpler 
to modify. Also, procedures always load the most current data from the server instead of 
predefined slides. The data can include Web (URL) and local images. It is also possible to import 
an entire slide show (Figure 46a) into the procedure. The auto-load capability can be used to 



continuously sequence through the bundles of a procedure. Each time a bundle is loaded, the most 
current data will be displayed. Like slide bundles, procedure bundles can also include frame 
animations. 

 

 
Figure 46a. Creating a procedure 

 

5. Creating a Briefing 



5.1 Your first slide show  
 Use the default folder or select a slide folder (press CTL-F or use the file submenu in the toolbar).  
 Select "New Slide Show..." under "File" on the menu bar and type in the name of your new slide 

show.  

 

 Ensure slide composition is set to "Text overlay" (not background image, and for a single frame).  
 Select "Create Slide" on the slide show popup menu. This will display a template chooser menu.  



 

 Select the desired template and click "Open".  
 The template with its editable fields will be displayed. To accept, click "OK".  
 This will display the text in the main window and also add it to your presentation.  



 

 You just created your first slide show containing a single slide!! 
 Select "Edit Text..." on the popup menu to make any changes to the text. 
 Exit slide show by selecting "Close" on the slide show menu. Your slide show is automatically 

saved as you create slides.  

5.2 Spruce up your slide show 
Add a background to your slide and append a slide with meteorological data.  

 Depress the space shuttle icon on the menu bar.  
 Select your slide show from the popup window chooser.  

Note: The folder remains the same as before.  



 

 Select the "key" icon next to your slide name. This will show the components of the slide.  
 Select (i.e. highlight) the image component of your slide.  
 Move the mouse cursor to the main window (to activate the window); press CTL-B and watch the 

default slide background appear (if another background is desired, select "Load GIF/JPEG/PNG 
..." under "File" in the menu bar).  



 

 Select "Replace" on your slide show popup menu.  
 You just added a background to your slide!!  



 
Now, let's add a radar image slide consisting of four frames to your slide show.  

 Select your preferred scale and loop length, and load a radar product.  
 On your slide show popup menu, define the slide composition: select "Background image" and 

deselect "Text overlay" and "Single-Frame Slide".  



 

 Select "Create Slide".  
 You just added your second slide consisting of a radar loop!!  

5.3 Add a slide of an annotated weather display  
Let's create a slide that consists of four frames of meteorological data, where each slide has its own 
graphic annotation. Here we go ...  

 Select your preferred scale and loop length, and load a satellite product.  
 Enable the drawing tool by pressing CTL-D (or select Drawing from the menu bar under Tools).  

----  
 Step to the desired (first) satellite frame.  
 Select the Freehand tool from the tool bar.  
 Draw a line around a significant weather feature (click mouse button 1 at the starting location, 

draw the desired shape, then click mouse button 1 to complete the line; use the eraser icon to 
delete a previous drawing object).  

 Save drawing as Graphic 1 under the diskette icon on the tool bar.  
----  



 Do the above three steps for each additional frame, saving the drawing as Graphic 2-4 
corresponding to the frame number. When done, clear all graphic objects by selecting the "white 
page icon" on the tool bar. All that should be displayed now is the satellite product.  

 Now, reload your drawings by selecting "Graphic Sequence" which is found under "Obs > Local 
Graphic" on the menu bar. This will overlay your graphics on the individual satellite frames. You 
can verify this by stepping through or animating your frames.  

 

 You may need to adjust line width or color (using the product label) since these attributes were 
lost. When satisfied, save your work ...  

 On your slide show popup menu select "Background image" and deselect "Text overlay" and 
"Single-Frame Slide").  

 Select "Create Slide" on the slide show popup menu.  
 That's it!  



 

5.4 Insert a D2D display into your slide show 
 Easy task! First display the desired product on your D2D display.  
 Maximize the display by moving the left edge of the D2D product window all the way to the left.  
 On the Briefing Tool (FXC) select "Capture D-2D Display" under "File" on the menu bar.  
 On your slide show popup menu select "Background image" and "Single-Frame Slide", and 

deselect "Text overlay".  



 

 Select "Create Slide".  
 You're done!!  

5.5 Need a very custom slide (existing templates won't do)? 
 Load the default slide background by pressing CTL-B (if another background is desired, select 

"Load GIF/JPEG/PNG ..." under "File" in the menu bar).  
 Activate the drawing tool by pressing CTL-D (or select Drawing under "Tools" in the menu bar).  
 Use the drawing tool to write text or create tables or charts. When done, save your graphic as a 

slide...  



 

 On the slide show popup menu select "Background image" and deselect "Text overlay" and 
"Single-Frame Slide".  

 Select "Create Slide".  
 You just created a custom slide!!  

Note: You can save your text and drawings for later re-use or modification by selecting the 
"diskette icon" and then Graphic 9-12 on your drawing toolbar.  

5.6 Let's rearrange the slides in our presentation 
Perhaps you need to move some slides ahead of others and replace the very last slide with a new one.  

 On the slide show popup menu select the slide you want to move up or down and then click on the 
"Move Up" or "Move Down" selector to move the slide to the desired location.  

 Now, select (i.e. highlight) the very last slide.  
 Select "Text overlay" and "Single-Frame Slide" and deselect "Background image".  
 Select "Replace". A dialog with the templates will appear. Select the desired template and click 

OK. The new slide just replaced the last slide in your presentation.  
 Your slide show is ready for viewing!!  



5.7 Showing real-time data and text slides 
 Easily done! At any time during your slide presentation you can load and display real-time data 

from the menu. You don't need to exit the slide show, and can resume your slide presentation 
exactly where you left off.  

 Alternatively, you can create a "Procedure" in advance that defines all the products you want to 
show and insert the entire text slide show into that procedure. If all you want is a single text slide, 
you can do that too. Note, however, that text slides can be modified only in a slide show.  

 Onward to more advanced stuff ...  

5.8 Changing a template 
This will require some knowledge of HTML, although some HTML editors such as Netscape 
Composer may work. It is often easier to use a text editor to modify the HTML file since this 
provides more control over the final appearance of the slide. The HTML templates are write 
protected and the modified files must be saved with a different name. Special tags are used to 
identify text fields that can be modified from a slide show menu.  

 

5.9 Adding editable fields into your HTML template 



The @@ symbols are used to delimit fields that are to be editable from the menu. These fields will 
be displayed when selecting "Edit Text..." in the slide show menu. The following editable fields 
are supported by the Briefing Tool (FXC).  

1. Simple editable text field: 
@@ text text text @@ 
Example: @@No significant weather@@ 

2. Simple editable text field with label "Temp": 
Example: Temperature:@@Temp=55 deg@@ 

3. Colored text field (the first color is the default color): 
@@|color1|color2|color3=text text text@@ 
Example: @@|black|white=Hello World@@ 

4. Colored text field (where the text is the name of the color): 
@@text text text~color1|color2=color1@@ 
Example: @@Lightning~green|red=green@@ 

5. Editable text Matrix: 
@@any valid exp@@ @@_any valid exp@@ (Note the "_" to continue a row): 
Example (3 rows x 2 columns): 
Rule 1 @@Now~green|red=green@@ @@_T0~green|red=green@@ 
Rule 2 @@Now~green|red=green@@ @@_T0~green|red=green@@ 
Rule 3 @@Now~green|red=green@@ @@_T0~green|red=green@@  

The template files are found in /awips/fxa/FXC/fsl/data/templates/[Western|Eastern]Range/.  

5.10 Automating a slide briefing 
Let's insert our slide show into a procedure, and then let the system automatically step through the slides 
and real-time data displays.  

 Open up an existing procedure by selecting it from the file submenu in the menubar.  
 In the procedure popup menu select "Insert Slide show.." and select the desired slide show in the 

popup chooser window. The procedure popup window will be updated with the slides from the 
slide show.  

 Use the UP or DOWN arrows to properly place the slides in the procedure.  
 Before activating the auto-sequencing, select each item in the procedure and adjust the dwell for 

that item at the bottom right of the procedure menu.  
 After you are satisfied with the dwell times, select and activate the auto-update selector.  
 You may need to load the first item before the sequencing starts.  
 That's it! If you need to change the dwell time or replace an item, stop the procedure and then 

perform the appropriate action as described elsewhere in this document.  
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